Introduction to Legacy HawkSoft
Help Documentation

Version 5 of the HawkSoft Management System has reached its end of support. The following doc-
uments are an offline copy of the legacy Version 5 online help portal, provided as a courtesy to your

agency, which has elected to remain on HawkSoft version 5.

Please keep the following in mind as you navigate this help documentation:

* To prevent issues with size, portability, and navigability, the Version 5 help documentation has
been split into nine PDF files (including this one). If a help topic contains a link to a different topic
which does not seem to function properly, it most likely links to a topic contained in a different

PDF file. In that case, try searching the other PDF files for the topic named in the link.

* While some topics may mention contacting Product Support for assistance, please note that
HawkSoft Product Support assistance of any kind is no longer available for this version
of HawkSoft.

* While we have done our best to remove any topics relating to online features that are no longer
functional, this help documentation may still contain references to features which are no longer

functional due to HawkSoft 5's end of support.

* Help and training videos are not available in this help documentation. However, you may still

occasionally see references to help or training videos in this documentation.

HawkSoft Tips and Tricks [Tips & Tricks]

Welcome to HawkSoft's Tips and Tricks! We hope you will find the following shortcuts and useful busi-

ness practices helpful in streamlining your workflows and increasing your productivity.
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Right-Click Menu Log Notes

Right-Click Menu Attachments

Quickly Copy Client/Policy Data

Open an Additional Instance of HawkSoft in a

Second Window

Refresh a Client

= User Preferences

= Customize Columns on the Client File View
= Customize Columns when viewing Claims
= External Tools

= Toolbar Shortcuts

= Policy Snapshots

= Keyboard Shortcuts

Need Help? Chat Us!

If you have a tip or trick that you'd like to see posted, please email helpsystem@hawksoft.com.
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Please include "Tips & Tricks" in the subject line.

Log Notes Right-Click Menu

Once a Log Note is created on a client/policy, you can open the Log to review the notes and perform
additional actions on the Log. Additionally, a menu is available from the Log Note list, enabling you to

take the same actions without opening the Log.

Using the right-click menu in the Log Note win-

dow

To open the menu, open a client file, and then right-click on a selected Log Note in the Log

Note window.

Menu Item Function
View Expand or zoom the selected log entry.
Brint Print the selected log entry to your printer or the HawkSoft CMS Vir-
rin
tual Printer.
Right-click on a selected log note to create a new log entry and link
New Log it to a selected log entry.
See Linking Log Notes for more information.
Add additional information to the bottom of the selected log entry.
Append Log
See Appending a Log Note for more information.
Copy the selected log entry to another policy or client. This option
also gives you the opportunity to void the log entry from the original
location once the copy is complete.
Copy to

See Moving a Log Note for more information.
NOTE: Attachments will NOT be included with the copied/moved
log note. See for more information.
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Menu Item Function

Create a Suspense for the selected log entry.

See Suspending a Log Note for more information.
Suspend

NOTE: This menu item is ReSuspend if the log has been sus-

pended.

Close a suspended log entry.
Close Suspense
See Accessing and Working with Suspenses for more information.

Create a tag on a Client file.
Add Client Tag
See Client Tags [+video] for more information.

Void the selected log entry.

See Voiding a Log Note for more information.

Void
NOTE: If the log note is suspended, void will not be an option until
the suspense is closed.
Restores a log note that has been voided.
Unvoid NOTE: This menu item is only available when right-clicking on a

voided log note.

Show Voided View any log entry that has previously been voided on the viewed

Log Entries client file.

See the Log Notes Overview for more information.

Attachments Right-Click Menu [Tips & Tricks]

Once documents are attached to the client/policy, they are easily accessed from the Attachments List
in that client/policy. You can use the available right-click menu to open, modify, and manage attach-

ments.

This article describes the options that are available in the attachments right-click menu.
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While all users have access to the right-click menus in the client file, some features
may not be available based upon individual user permissions.

Using the right-click menu in the Attachment window

To open the right-click menu, click on the Attachments tab in a client file/policy, and then right-click on

one or more selected attachments to access the menu.

Menu ltem Function

Open the selected attachment in the CMS Viewer.

PDF attachments open in the CMS Viewer if Launch PDF file with

viewer associated with Windows is unchecked in General Con-

View

figuration Settings.

Create Working Docu- Modify an encrypted document, such as an Agency Checklist. See

ment Working Documents for more information.

Copy the attachment(s) to your Windows® clipboard, and then paste
c into another location, such as your desktop or an email. Once pasted,
o
Py the attachment keeps the Description name as the file name. See

Save Attachments to Your Computer for more options.

Copy the file path to your clipboard. Useful for carrier websites that
Copy Path upload documents from pasted file paths. See Upload Attachments to

a Carrier Website for more information.

Send the attachment for electronic signature.
See Send Document for E-Signature for detailed steps.

Send for E-Signature
See E-Signature Configuration: DocuSign or

RightSignature to configure E-Signature with your
vendor.

Track Submission Track the document once it has been submitted to a carrier.
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Menu ltem

Function

See Track Submissions for more information.

Select an attached email, and then select Email > Reply, Reply All,

Forward, or Send as Attachment.

OR

Email Select an attached document, and then select Email > Send as

mai
Attachment.
The attachment will retain the Description as saved in the Attach-
ments List.
See Email for instructions on emailing from the Attachments list.
Copy the attachment(s) to the Unmatched Documents Inbox and
Copy To (Unmatched

Documents Inbox)

retain a copy on the existing policy.

Once copied, the attachment keeps the Description name as the title.

Copy To (Other Cli-
ent/Policy)

Copy the attachment(s) to another client or policy, and retain a copy

on the existing policy.

See Copying an Attachment for instructions.

Move To (Unmatched

Documents Inbox)

Move the attachment(s) from the client file to the Unmatched Docu-

ments Inbox.

This archives the attachment on the Client/Policy. To restore the

attachments on the original client file, see Restore.

Move To (Other Cli-
ent/Policy)

Move the attachment(s) from the current client file to a different client

or policy.

This archives the attachment on the Client/Policy. To restore the

attachment on the original client file, see Restore.

Assign Document for

Review

Send the attachment(s) to a CMS user for review and processing.

Mark as Reviewed

Updates the Last Processed/Reviewed By column with the current
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Menu ltem

Function

date and your name as the reviewer.

Compare to Previous

This menu option appears only when a Policy Snapshot or Download
is selected. Compare changes between two downloads or Policy

Snapshots created in CMS.

This selection is available only for Policy Snapshot
attachments, or attachments received as part of a
carrier Policy download.

See Comparing Downloads and Policy Snapshots for more inform-

ation.

Add New Log

Create a new log note and link the attachment.

See Linking Attachments to a Log Note for more information.

Link To Log

Link the attachment to an existing log note.

See Linking Attachments to a Log Note for more information.

Archive/Delete

Select Archive to remove the attachment from view. The file can be
viewed and/or restored, if needed. See Archiving/Unarchiving an

Attachment for more information.

If Archive Attachments is not checked in General Settings, Delete

appears as an option instead of Archive.

Select Delete to open the Delete Attachment dialog. You are promp-
ted to move the attachment to the Unmatched Documents Inbox.
From the Inbox, you can easily move the attachment to another file.
You can uncheck the Move this attachment to Unmatched Docu-

ments box to permanently delete the attachment, if needed.

Deleted files are recoverable only if they have
been saved to a backup file.

Restore

Select the Show Deleted/Archived Attachments option, highlight

an archived attachment, and then click Restore. This only applies to

3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1981



#Comparing%20Downloads%20and%20Policy%20Snapshots
../../../../../Content/Log Notes/Link Attachments to a Log Note.htm
../../../../../Content/Log Notes/Link Attachments to a Log Note.htm
#Archiving/Unarchiving%20an%20Attachment
#Archiving/Unarchiving%20an%20Attachment
#General%20Settings

Menu ltem Function

Archived attachments - Deleted Attachments cannot be restored.

Update policy information, such as coverages and premiums, from a

Policy download file.

Update Polic

P y This selection is available only for Policy Snapshot
attachments, or attachments received as part of a
carrier Policy download.

Send to Support Send the attachment(s) to HawkSoft Support for review.

Reset default column order. Default column order preferences are set
Reset Column Order in the User's profile.

See User Preferences for more information.

View any attachments that have been archived or deleted from this

policy.
Show Deleted/Archived

Attachments If you attempt to open an attachment that was pre-
viously deleted, you are prompted to insert the
backup disk that contains the image.

This option is available when using the Group By filter on the Attach-

Expand All
ment detail bar. Select Expand All to open each attachment group.
This option is available when using the Group By filter on the Attach-
Collapse All _
ment detail bar. Select Collapse All to show the group names only.
Open the properties view of the attachment file and edit as needed.
Properties

See Attachment Properties for more information.

See the Client File Right-Click Menus article for more information.
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Quickly Copy Client/Policy Data [Tips & Tricks]

When viewing a client/policy file:

* Click on blue data fields to copy the data to your Windows® Clipboard, and then paste the data

elsewhere, such as electronic forms and carrier websites.

* Click on underlined fields to open a dialog which displays additional information.

9 Start Page E} E. Example Incorporated =

Cust ID: 00000430 | Index Mame | | Linkto Client = | File Encryption |1D: 99999998 | Open in Ney
Corporation E. Example Incorporated Client Type Custormer
DEA Eddie Example Construction Status Active
Contact 1 Producer AME CSR AME
Contact 2 Office Honest Abe's Insurance#
Work Phone (503)123-4367
_Mgl_llnq 123 Any Avenue Cell Phone (303)234-5678
P._q:jr_ 5 Canb],r, OR 97013 Home Email ed ampleinc@pretendemail
Client  [1-A \\
Wehicles Click on a dotted Attachments ]’ Click onblue
underlineto open a
_C_qr:n_ga_ ny DAIR text to copy to
P window with additional
rograrm - ) Effective your cllpboardl
MAIC information. Expiration|
k.
Agent 1 2 3 Status Active
Agent Code Status Date 06/17/2017
Production Date 03/01/2011

For example, if you click on the underlined Company field, a dialog displays additional Company inform-

ation.
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keep the window
open.

| Company Iﬁfcl'ljjﬁﬁ;d_'_.__,_,_._.-j

I —
P \

Click onthe pin to }
)

Company DAIRYLAND __ﬁ//( Click to copy
Address 1800 NORTH POINT DRIVE M blue text
STEVENS POINT, WI 5448 L

Launch https://www.dairylandauto.com/

Type Phone/Email Description Profile/Name

Email info@dairyland.com Email

Phone 800-434-43334 Customer Service

Phone 1-800-874-4453 Underwriting

Phone 1-800-833-2244

Fax  1-602-860-7702 Highlightapmne\l

~. numberandclick
Call Now

Call Now

J

A

See Tour of the Client File for more information.

Open an Additional Instance of HawkSoft CMS [Tips & Tricks]

Did you know you can quickly open a second instance of CMS? You might be in the middle of entering
information in a client file and then you receive a phone call from a customer. Now you want to open an

additional client file without closing the file you are editing.

HawkSoft provides multiple options for opening a second instance. You can always use the following

keyboard shortcut or click the available button, depending on what screen you are on.

e Ctrl+Alt+N
Click Ctrl+Alt+N from any screen in HawkSoft.
The following buttons are available during workflows that most commonly benefit from

information verification from another screen. With the click of a button, you can open a cli-

ent file in and additional window.
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¢ ACORD Form Editor

~ . OpenClient In New Window

_~
jﬂﬂﬂﬂ. CERTIFICATE OF PI

¢ Form Letter Editor

€) CMS Letter Editor - [Test]

File Edit Format Inset View Tools Help

n b | e - H = -~ p " Open Client In Mew Window
, T -

Times New Roman - | 12 A A | B I v, L [

* Email Editor

‘/‘: Mew Meszage
g

= - b T @

—— (- - e ey  Open Client

¢ CMS Edit Client/Policy screens

Open Mew Window A

Now you can open an additional client file without exiting out of the file that you are working on.

Refresh a Client

You can check for updates on your currently open client file without closing it. To check for updates

click on the Refresh Client button, or press F5.
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e

Cust |D: 00009376 & Masked Index: Mame 2 Refresh Client

Corporation E. Example Incorporated Client Type Custo ommercial)
DEA Eddie Example Construction Status Pr ct
Contact 1 Example, Edward (Eddie) Producer CMH CS5R DM
Contact 2
Waork Phone (503)123-4567 (Example, Edward)
Mailing 123 Any Avenue Cell Phone (503)234-5678 (Example, Edward)
Address Canby, OR 97013 Mare..,

User Preferences [Tips & Tricks]

Did you know you can configure your own personal default search parameters when retrieving a client
file, as well as control the way HawkSoft CMS organizes client file information, policies, and attach-

ments?

Take a few minutes to review all of the options in User Preferences and configure these settings in a

way that is most useful to you. Your preferences will not impact any other users in your agency.

You can access and modify your preferences in a few different ways:

From the CMS menu bar

1. Click the drop-down arrow next to your user name on the CMS menu bar, and then select User

Preferences.
The Preferences dialog opens.
2. Modify preferences, as needed.
See User Preferences [Tips & Tricks] below.

3. Click OK to save your changes and close the Preferences dialog.

From the User Profile dialog

1. Click theE Settings icon, and then select User List.

The HawkSoft User List dialog opens.
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If you are editing your own profile, and do not have User List permissions,
CMS immediately opens your user profile. Skip to step 3.

2. Select a user, and then click Edit.

The User Profile dialog for that user opens, with the General tab selected.
3. Click the Preferences side-tab.
4. Modify preferences, as needed.

See User Preferences [Tips & Tricks], below.

5. Click Finish to close the User Profile dialog.

For users without User List permissions, this step closes the User Profile dia-
log.

6. Optional: Click Apply to save the User List changes and add or edit additional user profiles.

7. Click OK to close the User List dialog.

From the Search dialog

Q

1. Click the 3earch pytton on the main CMS toolbar.

The Search dialog opens.

2. Click User Preferences at the bottom of the Search dialog.
The Preferences dialog opens.

3. Modify preferences, as needed.
See User Preferences [Tips & Tricks], below.

4. Click OK to save your changes and close the Preferences dialog.

5. Continue to search for a client, or click Cancel to exit the Search dialog.

See User Preferences for a detailed explanation of each setting.
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Customize Columns on the Client File View [Tips & Tricks]

Did you know you can determine the Personal Profile information and Policy information you want to
view when opening a client file? Customized column views allow you to quickly display the information
you most often need to view. Customized column views will automatically save and display each time

you choose to view the Personal or Policy data.

To customize the column view

1. Select the client file.

2. Click the Client tab.

3. Selectthe Personal or Policies tab.
4. Right-click in the heading row.

The drop-down menu opens and displays the customized column options. You can use this
menu to determine the data/columns to display on the Policies tab and/or Personal tab, and you

can determine how the data fits within the columns to minimize extra space.

2-HOME (Prospect) 1-AUTOP (Prospect)

Contacts Misc Info Policies Logs Wersions Sys Info Product Mgmt Personal

Policy View Options | Displaying policies active in the last 80 days, Prospect Polides, Canceled/Expired Policies Client Annualized Premiv

Policy Status Company Effective Expiration Paolicy # Cur. Rate
2-HOME (Prospect) Prospect <Prospect= 05/01/2021 367890 0.00 \F@
1-AUTOP (Prospect) Prospect «Prospect> 05/01/2021 123436 0.00 Action Mer
Determine data/columnsto Customize
display Reset Colur
h | - Fit to Colur

L
e T // Fit to Wind
Adjust how the data fitsin ;//
each column L

o v

To determine the data to display

You can select the policy data and personal profile data that you prefer to see when opening a cli-

entfile.
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1. Select Customize Columns from the drop-down menu.

The Customize Fields list opens with a list of data fields from the General Policy Inform-

ation screen or Personal Profile screen.

Customize Fields >

Select which columns you would like displayed:

Columns ~

Folicy

[] Policy Form

[] application Type
] LoBs

Status
Company

[] status Dt

|:| Incep Date
Effective
Expiration

[] Term o

2. Select the fields you would like to display in the columns.

The Personal Profile or Policies list will now display only the data/columns you have selec-
ted.

To move the columns

1. Select the Personal or Policies tab.

2. Left-click on a column header and drag it right or left to reorganize the columns.

2-HOME (Prospect) 1-AUTOP (Prospect)

Contacts Misc Info Policies Logs Wersions Sys Info Product Mgmt Personal Attachme

Policy View Options | Displaying policies active in the last 80 days, Prospect Polides, Canceled/Expired Policies Client Annualized Premiv

Policy * LOBs  Status Policy # Company Cur. Rate Term Effective Agéhﬂ Statu:
2-HOME (Prospect) HOME Prospect 567830 <Prospect= 0.00 12 Months  05/01/2021 MNOC 04722
1-AUTOP (Prospect) AUTOP Prospect 123458 <Prospects 0.00 12 Months 05/01/2021 MNOC 04,22

The customized column view settings will automatically save and display each time you choose to view

the Personal or Policy information.

You can reset the columns to display the default columns, if needed.
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See the Client File Right-Click Menus article for more information.

Customize Columns when viewing Claims [Tips & Tricks]

You can easily view Claims information on a selected client or policy. To view all claims for all policies

on a client, select the Client tab, or select a specific policy to view claims for only that policy.

1.

2.

3.

Select the Claims tab for the Client or policy.

By default, CMS displays the most commonly viewed information from each claim.

Client F-AUTOP 2-Home 1-HOME

GPI Logs Fees Claims Attachments

Clairn Mumber LossDate  Reported Date  Claim Status  Claim Type  Risk Marne
1 09/05/2017 10/02/2017 Open Collision Auto

You can right-click in the Claims list, and then select Customize Columns to add or remove

columns.
The Customize Fields dialog opens with a list of each of the Claims fields on the Claims screen.
Select or unselect the fields to view the Claims data as needed, and then close the dialog.

* Your column settings are saved for all client/policies
* Your customized view doesn'timpact other users
* Your customized column settings are applied separately for the Client view and Policy
view
You can reset the default column settings at any time.

Right-click in the Claims list, and then select Reset Columns.

See the Client File Right-Click Menus article for more information.

Shortcuts to Websites and Programs [Tips & Tricks]

External tools allow you to configure shortcuts that link to a website or program (application) of your

choice. These links can be set to appear on the Tools menu, the Quick Launch panel, and/or the main
CMS toolbar.
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External tools can launch applications only if the application is installed on the
same computer CMS is running on.

To set up a website or program

1. Click theE Settings icon, and then select Computer Specific Settings from the

main CMS menu bar.
The Computer Specific Settings dialog opens.
2. Click the External Tools tab.
3. Click New to set up a new external tool, and complete the following:
* Tool Name — Name the external tool.

* Tool Type — Select Program (application) or Website from the drop-down

list.

* Tooltip — Enter the tool name as you want it to appear when you hover your

mouse over the toolbar icon.

* Help Text — Enter a description of the tool. This can include the keyboard

shortcut associated with the toolbar button.

This description appears as part of the Tooltip when you hover your mouse

over the toolbar icon.

e Command — Enter or browse to the program (application) path or website
URL:

° For awebsite, enter the URL
° For a program, enter the path to the .exe file

See the following table for a list of common programs and commands:
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* Arguments — Use to send command line arguments to the EXE. (Optional:

Used only when the tool type is Program.)

* Initial Directory — This field automatically defaults to the same path as the

Command field. (Optional: Used only when the tool type is Program.)

¢ Select Show on Tools Menu, Show on Quick Launch Panel, and/or Show

on Toolbar to designate where links to the tool appear.
4. Click Test to verify your setup.
Your program or website launches.
5. Click OK to save changes and return to the External Tools screen.
6. Click OK to close the Computer Specific Settings dialog.

A link to the new tool displays in CMS at the designated location.

Additional button options on the External Tools screen

* Edit — Highlight an item from the list, and then click Edit to modify.
* Delete — Highlight an item from the list, and then click Delete to remove the link.

* Arrows — Highlight an item from the list, and then click the Up or Down arrow to

move the items up or down on the list.

* Separator — Click to insert a dividing line that displays between external tools you
have designated to show on the main CMS toolbar. If selected, CMS adds a sep-
arator to the bottom of the external tools list, and then you can use the navigation

arrows to place the separator.

See Shortcuts to External Tools for more information.

Toolbar Shortcuts [Tips & Tricks]

The main toolbar in HawkSoft CMS contains several buttons which provide shortcuts to perform com-
mon transactions in CMS. You can customize the toolbar by adding buttons to provide additional short-
cuts for common tasks performed by your agency and you can remove buttons that your agency

doesn't use.
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Changes to the toolbar, which include Action menu shortcuts, are seen by all users
in the agency and cannot be customized for an individual user. See Customizing
the CMS Toolbar for required permissions and more information.

Default Action menu toolbar buttons

The buttons below are included with the CMS installation. These buttons provide shortcuts for Action

menu transactions and create a log note documenting the transaction. These buttons cannot be mod-

ified, however they can be removed and new buttons can be added.

Default But-

{o]1]

Action Menu Shortcut

Mail > From > Company > Change Policy Status > Cancel See Changing Policy

Status for more information.

Mail > From > Company > Change Policy Status > Issued See Changing Policy

Status for more information.

Mail > From > Company > Change Policy Status > Reinstate Opens the Rein-

statement Date dialog. See Changing Policy Status for more information.

Mail > From > Company > Change Policy Status > Renew Opens the Renewal Date
dialog and additional screens for modifying the policy. See Changing Policy Status for

more information.

Endorse

Mail > From > Company > Change Client/Policy

Opens the Premium Change dialog.

Invoice

Mail > To > Insured > Print > Invoicing

Opens the Invoices and Payments dialog .

$

Payment

Walk-in > From > Insured > Payment

Opens the Payment dialog box to create a receipt when the insured comes into the
office. If there is an invoice with a balance due, the Open Invoices dialog box opens

enabling you to apply the payment to any open invoices.

I Use the Action menu to document money received from a cus-
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Default But-

ton

Action Menu Shortcut

‘ tomer in any other manner, such as Mail > From > Insured.

[+ ) I i
nternal > Accountin
=) 9

Accounting | 5hens the Accounting menu.

To customize the Action Menu toolbar options

1. Click theE Settings icon, and then select General Configuration from the main CMS menu

bar.
2. Select the Action Menu Customize Toolbar side-tab.

A table opens with a description of the icons currently on the toolbar.

Action Menu Customize ToolBar

Button Title Policy Type Hotkey Action Mew
=Cancel Al Types Ctrl +C Mail, From, Company, Change, Policy Status, Cancel Edit
OIssued All Types Ctrl +1 Mail, From, Company, Change, Policy Status, Issued
@Reinst All Types Ctrl +R Mail, From, Company, Change, Policy Status, Reinst Remove
@Renew All Types Ctrl + M Mail, From, Company, Change, Policy Status, Renew

Endorse &l Types Ctrl +E Mail, From, Company, Change, Premium i@ 3
| SEPARATOR All Types
In'uni::e Client & Policy Ctrl +3 Mail, To, Insured, Print/Create, Inwvoicng Separator
E Accounting  Client & Policy  Ctrl + 5/%%  Internal, Customer Accounting
5 Payment All Types Ctrl +4/¢  walkin, From, Insured, Payment Rec'd

Policy Type — The types of policies the button can be used with

Hotkey — The keystrokes that launch the action

Action — The Action menu steps performed when using this button.
3. Customize the toolbar as needed.

hen Click to create a new toolbar item.

Edit Select a previously added item, and then click Edit to make modifications.
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#Trust%20Accounting%20Overview*

a. Complete the Setup dialog to create a new item or modify an existing item:

Setup 7 >

Customize ToolBar Item

Button Tite | Button Tite |

Tooltip | Tooltip |

Help Text | Help Text |

Press Shortout Keys:

Hotkey |Ctr| +9 -
Policy Action Type | all Types w
Action |

Icon IE Load Icon

QK Cancel

Button Title — The title appears below the icon image.
Tooltip — Pop-up text that appears when a user hovers the mouse over the icon.

Help Text — A brief description of the icon that appears below the Tooltip when a user hov-

ers over the icon.

Hotkey — CMS keystrokes that launch the action. The hotkey displays when a user hovers

over the icon.

Policy Action Type — Types of policies this toolbar item is used for.

Action — Click the ellipsis "**| button to open the Action menu, and then select the actions

this toolbar icon will perform when clicked.
Icon — Click Load Icon, and then select a Windows image to display for this toolbar item.

b. Click OK.

3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1996



Select a previously added item and then click Remove to delete the button from the

toolbar.

EI Click the arrows to change the position of a selected button.

Click to insert a separator to organize the buttons into sections.

Use the arrows to move the separator between two buttons.

Click to restore the toolbar to the CMS default items.

Custom icons will not be deleted when default items are restored.

4. Click OK when finished.

See Customizing the CMS Toolbar for more information or watch the following video:

Policy Snapshots [Tips & Tricks]

HawkSoft CMS enables you to create a Policy Snapshot after making changes to a policy. The Policy
Snapshot document looks like a policy download (AL3) file, and includes basic policy information, such
as carrier name, Insured's contact information, premium, policy dates, vehicle information, coverages,

etc.

When a carrier does not do downloads, using the Policy Snapshot feature is a good way to track and

compare manual changes made to a policy over time.

Once the Policy Snapshot is created, it is attached to the policy and the log note. You can open the

attachment from the policy, just like opening a policy download attached from a carrier. Like policy

downloads, the Download Compare tool can be used to compare two different Policy Snapshot files.
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#Policy%20Snapshot

How Policy Snapshots are created

Depending on your agency's configuration, Policy Snapshots are created automatically or they can be

created manually.
Automatically

If your administrator configured Snapshots to be automatically created each time a change is made to
a policy or has configured Snapshots for the specific carrier on the policy, you will notice the Policy

Snapshot attached to the Log Note after you have made your changes.

Once you have saved your Log Note, the Policy Snapshot is listed in the Attachments List for that

policy.

Add Log Entry Comments

Date &Time: 03/22/2022 12:32FPM
User: Jane Doe (NOC)

? >
Log Entry:  Phone From Ins Mew
Z

Ipdated policy status |
Mew Business - Effective Date: 0372272022

[ ]suspend Transaction {Tickler)

Add Client Tag | 0 Client Tags Added

Double-dick on any item to edit properties.

Description Category
@P'::nli»::!,-I Snapshot

o Drag and drop files anywhere on this dialog to attach them to the customer's file, Open In Mew Window
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Prompted

If your administrator configured a Policy Snapshot prompt to appear after policy changes are made,

you can determine if a snapshot should be created based on the changes you just made to the policy.

HawkSoft CMS

o Do you want to create the policy snapshot?

Yes Mo

Manually

If your administrator has not configured Policy Snapshots to be created automatically or when promp-
ted, you can choose to manually create a Snapshot after you have saved your policy changes. You

must have permissions to the Internal Action Menu to manually create a Snapshot.

1. Select a client file to open.

2. Click on the policy you would like to create a Policy Snapshot for, and then click on the Action

Menu.
The Action Menu opens.

3. SelectInternal, and then select Create Snapshot.
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Action Menu.htm#Using_the_Internal_Action_Menu

Action

Int

Choose an action to perform, ﬂ
Merge Clients ~
Archive Client

Links to Client(s)
Customer Accounting
Invoicing

Scan

Print/Create
Inguiry/Website
Send Email

ACORD Forms

Quote Export I

Log

Reindex

Convert Policy Type
Edit Policy History

Done

< Back Finish

The Add Log Entry Comments dialog opens.

The Policy Snapshot is automatically attached to the Add Log Entry Comments dialog.
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Creating a Log Note.htm

Add Log Entry Comments ? >

Date &Time: 03/16/2022 05:51PM
User: Jane Doe (NOC)
Log Entry:  Int Create Snapshot Cancel

A (B||l7||0| A ¥

OK

Add comments as needed |

[ ]5uspend Transaction {Tickler)

Add Client Tag | 0 Client Tags Added

Double-dick on any item to edit properties,

Description Category

@ rolicy Snapshot h

0 Drag and drop files anywhere on this dialog to attach them to the customer's file. Open In Mew Window

4. Add comments, as needed, to the Add Log Entry Comments dialog, and then click OK.

The Policy Snapshot is now attached to the policy and can be found on the Attachments tab on the

policy file.
GPI Logs Fees History Attachments
| Description Search (Alt4E) ,D| Group By | None ~ | []Show attachments for all polices
Date Attached Desn:ripﬁgn Category  Type Lser Status  Effective Date  Last Processed/Reviey
@ 03/16/2022  Policy Snapshot Policy Snapshot  Jane Doe (NOC) 03/16/2022 03/16/2022 Jane Doe

Reviewing the snapshot of a policy
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When a Policy Snapshot is created, it is attached to the policy just like a downloaded policy change.

The policy snapshot attaches to the log note and you can open the file from the Attachments tab.

Select a Policy Snapshot from the Attachments List, and then use the right-click menu to select one of

the following options:
View

Select View or simply double-click on the file to open the Snapshot in the CMS Viewer.

View — Select to open the file to review policy information.

Client 1-AUTOP

GPI Logs Fees History Attachments
| Description Search (Alt+E) ,D| Group By | Mone ~ | []show attachments for all polices
P

Date Attached Description Cateqory  Type ser Status  Effective Date  Last Processe:
03/16/2022 obe

Pelicy Snapshot L e iy - 03/16/2022 )
View
Create Working Document

Copy
Copy Path

Send for E-Signature

Track Submission

From here, you can assign the Snapshot to another user for Review or click Compare to

previous to compare to a previous Snapshot or download
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#Documents%20for%20Review

a 97% |7 a | Update Policy | Mark as Reviewed | Assign for Review Cumparetuprwiuush

Private Passenger Automobile

SELECT ¥OUR DESIRED IN SUR Po

Mamed Insuredis)

TEST MAME Palicy Mumber:
123 Fake 5t Agency [D: 00000523
Three Rivers, MA 01080
Premium: 0.00
Cell Phone: 112223333 Term: 12 Months
Email: testname@testemail.com Inception Date: 03Me2022
Transaction Date: 03M6/2022
Effective Date: 040152022
Expiration Date: 040172023
Private Passenger Automobile
Premium: 0.00
Effective Date: 04/01/2022
Locations
[ Location 1
122 Fake &t

Three Rivers, MA 01080

Additional Policy Information

[ Insured Information

Mamed Insured

Gender: Male
Marital Status: Single

The insurance policy information contained herein is produced from data contained in the Client Management Systemn anc
coverage provided by an insurance policy. Please refer to the insurance policy issued by your insurance camier for oo

See Working with Attachments to learn about other available options from the right-click menu, such as

sending the Snapshot attached to an email or to request an eSignature.

See Policy Snapshot for more information.
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Keyboard Shortcuts

Speed up your daily workflows by learning a few key-stroke combinations!

FUNCTION KEYSTROKE Available From
Action Menu ENTER Client File
PAGE UP/PAGE
Previous/Next Client Client File
DOWN
Move forward across multiple client files and Start Page, Client
CTRL + TAB
the Start Page File

Move backwards across multiple client files CTRL + SHIFT + Start Page, Client
and the Start Page TAB File

Move from policy to policy. Also opens the

LOBs (Lines of Business on policies with mul- | SPACE BAR Client File
tiple LOBs.)
TAB or
Previous/Next Policy Client File
SHIFT+TAB
Navigate Policy Detail Tab LEFT/RIGHT Client File
Previous/Next Log Entry or Attachment UP/DOWN Selected Item

Start Page, Client

Opens the Help System F1
File
CTRL+O
Start Page, Client
Opens the Search dialog OR
File
F2
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FUNCTION KEYSTROKE Available From

Start Page, Client
Opens the Suspense List F3
File
Open the selected Log Entry (Client File) or
F4 Selected Iltem
Attachment (Attachment List)
Refresh Client File F5 Client File
_ Add Log Entry Com-
Close the Add Log Entry Comments dialog F10 .
ments dialog
Start Page, Client
Opens the Client Menu ALT+F
File
Start Page, Client
Opens the Policy Menu ALT+P
File
Start Page, Client
Opens the Report Menu ALT+R
File
Start Page, Client
Opens the Accounting Menu ALT+A -
ile
» Start Page, Client
Opens the Utilities menu ALT+U -
ile
E Start Page, Client
Opens the Settings menu ALT+S Filo
Start Page, Client
Opens the View menu ALT+V
File
Start Page, Client
Opens the Help menu ALT+H -
ile
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FUNCTION KEYSTROKE Available From
Mail>From>Company>Change Cancelled CTRL+C Client File/Policy
Mail>From>Company >Change>Issued CTRL+I Client File/Policy
Mail>From>Company Change>Reinstate CTRL+R Client File/Policy
Mail>From>Company>Change>Renew CTRL+N Client File/Policy
Mail>From>Company>Change>Premium CTRL+E Client File/Policy
Online To Company Inquiry/Website CTRL+W Client File/Policy
Opens another instance of CMS CTRL+ALT+N :Zrt Page, Client
Selects the indicated menu heading or list ALT +
item; in the Edit dialog box, moves the cursor UNDERLINED Selected List
to that field LETTER
Move through drop-down menu UP/DOWN Selected List

Need Help? Chat Us! [Tips & Tricks]

HawkSoft has a new Chat option to give you the support you need, quickly!

Chat Support is available Monday - Friday 7:00 AM - 3:00 PM (Pacific Time).

Chat Support is available for local users only.

To access Chat Support, click them Help icon in CMS.
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Honest Abe's Insurance®1: Amy Earhart (AME) ~ ﬁ- R
Get Help F1
Tour of CMS
_ Training Guides

HawkSoft University
What's New

HawkSoft Community
Carrier Download List

VAMNS Exchange

Chat Support

Support Session

Send to Support

Contact Hawk5oft

Select Chat Support from the menu to access the Chat dialog.
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®)  HawkSoft Chat-7a-3p PSTM-F — X

MName

Enter your name

Agency Name

Enter your company

Email

Enter your email address

Your Question

How can we help you today?

START CHAT

Enter your contact information and some information about what you need help with, and click Start

Chat.

A Customer Service Representative will reply shortly.

More Tips and Tricks
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